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This Turabian packet will help students format a Turabian paper, including the bibliography 

and footnotes. 

 

 
These handouts conform to Turabian 9th edition standards.  However, professors may change their requirements 

for individual papers.  One should consult with his or her professor for any special requirements.       
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Introduction 

          Lorem ipsum dolor sit amet, consectetuer adipiscing elit. 

Aenean commodo ligula eget dolor. Aenean massa. Cum sociis 

natoque penatibus et magnis dis parturient montes, nascetur 

ridiculus mus. Donec quam felis, ultricies nec, pellentesque eu, 

pretium quis, sem. Nulla consequat massa quis enim. Donec pede 

justo, fringilla vel, aliquet nec, vulputate eget, arcu. In enim justo, 

rhoncus ut, imperdiet a, venenatis vitae, justo. Nullam dictum felis 

eu pede mollis pretium. Integer tincidunt. Cras dapibus. Vivamus 

elementum semper nisi. Aenean vulputate eleifend tellus. Aenean 

leo ligula, porttitor eu, consequat vitae, eleifend ac, enim. Aliquam 

lorem ante, dapibus in, viverra quis, feugiat a, tellus. ultricies nisi 

rhoncus. Maecenas tempus, augue velit, Lorem ipsum dolor sit amet  

eu pede mollis pretium. Integer Aenean vulputate eleifend tellus. 

Aenean vulputate eleifend tellus. Aenean leo ligula, porttitor eu,  

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Ligula eget 

dolor. Aenean massa. vulputate eleifend tellus. Aenean leo ligula, 

porttitor eu, consequat vitae, um sociis natoque penatibus et magnis 

dis parturient montes, nascetur ridiculus mus Lorem ipsum dolor sit. 

Subheading 

          Donec quam felis, ultricies nec, pellentesque eu, pretium quis, 

sem. Nulla consequat massa quis enim. Imperdiet a Aenean leo 

ligula, porttitor eu, consequat vitae, eleifend ac, enim. Aliquam 

lorem ante, dapibus Aenean imperdiet: 

          Maecenas. Donec vitae sapien ut libero venenatis faucibus.  

          Lorem ipsum dolor sit amet, ligula eget dolor. Aenean massa.  

          Nulla consequat massa quis enim. Donec pede justo, fringilla  

          ve. Lorem ipsum dolor sit amet, Lorem ipsum dolor sit amet,  

          Lorem ipsum dolor sit amet, Lorem ipsum dolor sit amet.1 

 

Etiam ultricies nisi vel augue. Donec vitae sapien ut libero venenatis 

faucibus. Lorem ipsum dolor sit amet amet feugiat. 

 

            1Lorem Ipsum, Dolor Sit Amet (Consectetuer: Adipsicing Elit, 

2008), 123.  

 

 

1 2 

-or- 

Sample Pages 

The Turabian 

Manual uses the 

word “submitted,” 

but some DBU 

professors prefer 

the word 

“presented.” 

Check with the 

professor.  
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Turabian Basics 

 

Title Page (pgs. 388, 391-392 in the Turabian Manual) 

On the title page for a class paper, center the title and bold it. About seven spaces down, type one’s name, the 

course name and number, and the date of submission. See the first example on page 1. 
 

OR 
 

On the title page for a dissertation, type the following information centered: Dallas Baptist University, Title (in 

bold,) A Dissertation Submitted to (Professor’s Name) in Partial Fulfillment of the Requirements for the Degree 

of Doctor of (Subject), Department (ex. Department of Philosophy), by (the student’s name), location (Dallas, 

TX), and the date. See the second example on page 1. This is the standard title page in the 9th edition of the 

Turabian Manual, and many professors still prefer this style. Students should consult with their professors for 

specific guidelines.  
 

Margins (pg. 384) 

Set margins to one inch on all sides of the page.  In Microsoft Word, under “Page Layout,” click on “Margins;” 

set the measurements to “Normal.” This should set all margins at one inch. See special margins for dissertation 

in DBU’s supplemental manual. 
 

Pagination (pgs. 385-386) 

The 9th edition of the Turabian Manual allows each university to determine how to number the title page of 

documents; therefore, one should consult with his or her professor for pagination advice. Most professors, 

however, prefer that their students refrain from adding a page number to the title page of their assignments. If this 

is the case, one will need to start the pagination of his or her paper from 0. In Microsoft Word, double click on the 

header and check the “Different First Page” box under the “Design” tab. Then, go to the second page, double 

click on the header, and insert page numbers wherever the professor has requested or, if he or she has no 

preference, wherever one has decided to place them. After doing so, the number 2 should appear in the location 

that was selected. Now, right click on the page number, select “Format page numbers,” and put a 0 in the “Start 

at” box. Number 1 should now show on the second page, and the title page should have no page number at all. 

Ensure the page numbers are in Times New Roman and in 12-point font. The manual also advises that the page 

number can be placed either in the footer or header, depending on the professor’s preference. If the professor 

requests that the page numbers be found at the bottom of the page, simply follow the same directions above after 

double clicking the footer.  

Spacing (pg. 385) 

Double-space the body of the paper. Single-space footnotes, block quotes, and each entry on the bibliography 

page; however, a blank line is needed between each entry in the bibliography and in between each footnote. Leave 

an extra line between the word “Bibliography” and the first citation on the Bibliography page.  In Microsoft Word, 

the button for line spacing is found under the “Home” menu, in the “Paragraph” section. Under “Line Spacing,” 

select “Double” and check the box for “Don’t add space between lines of the same style.” 

Indents (pgs. 78, 155, 161-162, 361, 385) 

Tab once before all paragraphs and footnote entries.  For quotes five lines or longer, single-space and indent each 

line as a block quote with no quotation marks. See pages 3 and 5 of the sample paper available in physical form 

the Writing Center.  
 

Subheadings (pgs. 402-405) 

Turabian utilizes bolded subheadings to transition and indicate different sections of the paper. These are generally 

centered and in 12-point font. Some professors prefer these headings to be in all capital letters with no bolding. 

However, it is also acceptable to create a unique typography if it is used with consistency and your professor 

agrees (pg. 391). Second and third-level subheads may also be used if necessary, but in a typical class paper, one 

level of subheads is usually sufficient. If the natural length and format of the paragraphs leaves a subheading 
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dangling on the end of a page, it is preferable to insert an extra line to push that title and the accompanying 

information to the next page. See the UWC sample paper for examples. 

 

Names and Titles (pgs. 150, 154)  

Within the paper, the first reference to a researcher or author should include his or her entire name. In subsequent 

references, use only his or her last name.   

 

Titles of longer works like books and journals should be italicized, while titles of articles and chapters should be 

in quotation marks. 

 

Numbers (pgs. 331-341) 

The general rule for Turabian is to spell out numbers one through one hundred in subjects that use numbers 

occasionally, such as the social sciences. Spell out whole numbers followed by hundred, thousand, etc. In all other 

situations, use Arabic numerals. 

 

Formatting Citations 

 

Styles for Citing Sources in a Turabian Paper (pgs. 35-36, 142-143) 

In Turabian style, there are two citation options. The first uses footnotes or endnotes, and the other uses 

parenthetical references. The instructor will usually indicate which type of documentation to use. If the professor 

does not have a preference, the student may decide which method to use, and then use only that method throughout 

the paper. Since majority of professors desire footnotes or endnotes, this packet addresses this style for the sake 

of simplicity. If students are instructed to use parenthetical citations or if they choose to use them, the Writing 

Center has a separate handout that addresses this alternative. 

 

Why Cite?  

If someone else’s ideas or words are used to help create ideas and reach conclusions while writing, credit must 

be given to the author of the source; otherwise, it is plagiarism. Footnotes and endnotes are used to show where 

credit is due.  

 

Endnotes (pgs. 162) 

Endnotes are formatted like footnotes with a few exceptions. Rather than placing endnotes at the bottom of each 

page, students must place them on a separate page at the end of the paper before the bibliography page.  The page 

is titled “Notes.” The format of endnotes follows the same pattern as footnotes, so simply refer to the entries 

labeled “Footnote” when creating notes. Some professors want footnotes for Turabian papers, while others allow 

any of the citation formats. If a student is unsure of which format to use, he or she should consult with his or her 

professor. 

 

Basic Format of Footnotes (pgs. 157, 164) 

Footnotes should be inserted at the bottom of the page. In Microsoft Word, go to the “References” tab, then click 

the “Insert Footnote” button. Word should automatically insert a line that separates the footnote from the text 

and a number. Tab the number over once to indent the footnote. 

 

➢ The first time a source is used, all the publication information should be listed within the footnote. Each 

new source used within the paper needs a full-length footnote that nearly parallels the bibliography entry.  

➢ For all subsequent references to this source, omit publication information and include the author’s last 

name, a comma, and the page number: 3Jones, 23.  

➢ If two or more works from the same author are used in the paper, also include a shortened version of the 

title: 3Jones, Truth, 23. 
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➢ If two consecutive references are from the same source, use the term “Ibid.” This stands for “in the same 

place” (pg. 167). See the following examples:  

 

            1Firstname Lastname, The Writing Center Guide to Turabian Format: How to Write and Cite Properly 

(Dallas: Publishing Company, 2004), 73. 

 

 2Ibid., 17. 

 

 3Somebody Wroteabook, Another Book Title: Creativity in Naming (New York: Spaghetti Sauce 

Publishers, 1997), 27. 

 

 4Lastname, 12. 

 

 5Ibid. 

 

NOTE: When using footnotes or endnotes, most titles are capitalized using headline style. Capitalize the first word 

and all other words except unimportant prepositions, articles, and conjunctions. For most foreign language titles, 

sentence-style capitalization should be used for titles of works. Capitalize the first word and all proper nouns (pg. 

154). 

 

Bibliography (pg. 411) 

If using footnotes, include a bibliography at the end of the paper. This page is most often titled “Bibliography;” 

however, some types of bibliography will have different titles, such as “Sources Consulted” (pg. 155). This 

includes an alphabetized list of all the sources used during the writing of the paper. Leave two spaces between 

the title and the first entry, then single-space subsequent entries, leaving a blank line between each entry. Left 

align the first line of each entry; if an entry is two lines or longer, each subsequent line should be indented. This 

is called a hanging indent. See the following example. 

 

Lastname, Firstname. The Writing Center Guide to Turabian Format: How to Write and Cite Properly.  

             Dallas: Publishing Company, 2004.  

 

To format hanging indents in Microsoft Word, highlight the text, right click on it, and select “Paragraph.” Under 

the “Indents and Spacing” section, select “Special: Hanging.”   

 

Differences Between the Format of Footnotes and Bibliography Entries 

Note these few differences in citation formats: 

➢ Author Name: Footnotes format the author’s name as first name last name, whereas bibliography entries 

format the author’s name as last name, first name.  

➢ Indention: With footnotes, the first line is indented and any subsequent lines are flush to the left, whereas 

bibliography entries have a hanging indent (the first line is flush to the left, and subsequent lines are 

indented). 

➢ Punctuation: Footnotes use commas and parentheses to separate elements in the entry, whereas 

bibliography entries use periods.  

➢ Page Numbers: Footnotes include specific page numbers where the information was found, whereas 

bibliography entries only include page numbers if they indicate the pages of a complete article or chapter 

consulted. 

➢ Ordering: Footnotes are numbered and ordered according to where the information is introduced in the 

text, whereas bibliography entries are always alphabetized and not numbered.  
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Printed Sources 

 

The following are examples of citations for research from printed sources (books, magazines, newspapers, and 

other non-electronic sources). If online versions of printed sources have been consulted, refer to the “Internet 

Sources” section. 

 

Each entry should include all of the following information that is available about the source (pg. 141): 

➢ Author’s name    

➢ Book title 

➢ Article or chapter title  

➢ Page numbers for articles/chapters 

➢ Journal or magazine title 

➢ Volume, issue, edition, etc. 

➢ Place of publication 

➢ Publishing company 

➢ Copyright date 

➢ Editor, translator, etc.  

 

Book with One Author (pg. 171) 

➢ Footnote 

 1James Daniels, Postmodernism and Scripture: Cultural Analysis and Repercussions (Ennis, TX: Dallas 

Baptist University Press, 2006), 78-81. 

 

➢ Bibliography 

Daniels, James. Postmodernism and Scripture: Cultural Analysis and Repercussions. Ennis, TX: Dallas Baptist 

University Press, 2006. 

 

It is not necessary to include the state or country for well-known locations like New York, Oxford, or Chicago. 

For less well-known cities, include the state. 

 

Book with Two Authors (pg. 151) 

➢ Footnote 

 1Roman Jakobson and Linda R. Waugh, The Sound Shape of Language (Bloomington, IN: Indiana 

University Press, 1979), 78. 

 

➢ Bibliography 

Jakobson, Roman, and Linda R. Waugh. The Sound Shape of Language. Bloomington, IN: Indiana 

  University Press, 1979. 

 

Book with Three Authors (pgs. 151-152) 

➢ Footnote 

 1Jane Lee, Bryce Jones, and Henry Lope, The Enchanted Book (New York: Harcourt, Brace and World, 

1983), 98. 

 

➢ Bibliography 

Lee, Jane, Bryce Jones, and Henry Lope. The Enchanted Book. New York: Harcourt, Brace and 

  World, 1983.   
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Book with More Than Four Authors (pg. 152) 

➢ Footnote 
1Harry Potter et al., Hysteria Beyond Freud (Berkeley: University of California Press, 1993), 110. 

 

➢ Bibliography 

Potter, Harry, John Smith, Pocahontas Smith, and Arnold Schwarzenegger. Hysteria Beyond Freud. Berkeley: 

University of California Press, 1993. 

 

Book with an Author and Editor (pg. 172) 

➢ Footnote 

 1Thomas Briggs, Living with Plants, ed. Marlene Day (London: Methuen, 1998), 79. 

 

➢ Bibliography 

Briggs, Thomas. Living with Plants. Edited by Marlene Day. London: Meuthen, 1998. 

 

Editor or Translator as “Author” (pg. 173) 

➢ Footnote 

 1Richard McKeon, ed., A Study of Aristotle’s Life (New York: Random House, 1941), 33. 

 

➢ Bibliography 

McKeon, Richard, ed. A Study of Aristotle’s Life. New York: Random House,  

  1941. 

 

A Book with No Author or Editor (pgs. 173-174) 

➢ Footnote 

 1A Guide to Our Federal Lands (Washington: National Geographic Society, 1984), 26. 

 

➢ Bibliography 

 A Guide to Our Federal Lands. Washington: National Geographic Society, 1984. 

 

Two or More Books by the Same Author (pg. 157) 

➢ Footnote 

 1Will Durant and Ariel Durant, The Age of Voltaire (New York: Simon, 1965), 47. 

 

 2Will Durant and Ariel Durant, A Dual Autobiography (New York: Simon, 1977), 23. 

 

➢ Bibliography 

Durant, Will, and Ariel Durant. The Age of Voltaire. New York: Simon, 1965. 

 

———. A Dual Autobiography. New York: Simon, 1977.  

 

For all entries after the first, replace the author’s name with a 3-em dash. 

Entries with the same author should be inputted alphabetically, excluding articles. 
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A Work in a Collected Work (pg. 185) 

➢ Footnote 

 1Laura Hooten, “The Chicago Statement on Biblical Inerrancy and the Biblical Worldview,” in The 

Proceedings of the Conference on the Christian Worldview, ed. David Eugene (Ennis, TX: Dallas Baptist 

University Press, 2008), 117. 

 

➢ Bibliography 

Hooten, Laura. “The Chicago Statement on Biblical Inerrancy and the Biblical Worldview.” In The Proceedings 

of the Conference on the Christian Worldview, edited by David Eugene, 114-152. Ennis, TX: Dallas 

Baptist University Press, 2008. 

 

As seen in this example, page numbers might not always match. If different pages are referenced, the 

bibliography includes a used-page summation unless utilizing entire item.  

 

An Encyclopedia Article without an Author (pg. 190) 

➢ Footnote 

 1The Encyclopedia Americana, 1993 ed., s.v. “Mandarin.” 

 

Note: s.v. represents “sub verbo” or “under the word.” 

 

➢ Bibliography 

No bibliography entry is needed for well-known reference books. 

 

An Encyclopedia Article with an Author (pg. 190) 

➢ Footnote 

 1Jitendra M. Mohanty, “Indian Philosophy,” in The New Encyclopedia Britannica: Macropedia, 15th ed. 

 

➢ Bibliography 

No bibliography entry is needed for well-known reference books. 

 

A Multivolume Work (pg. 178) 

➢ Footnote 
1George Arthur Buttrick, ed. The Interpreter’s Bible, vol. 3, King, Chronicles, Ezra, Nehemiah, Esther, 

Job (New York: Abingdon Press, 1954), 18-29. 
 

2Stanley Sadie, ed., The New Grove Dictionary of Music and Musicians (London: MacMillan, 1980), 

vol. 12: 129. 

 

➢ Bibliography 

Buttrick, George Arthus. The Interpreter’s Bible. Vol. 3, Kings, Chronicles, Ezra, Nehemiah, Esther, Job. New 

York: Abingdon Press, 1954. 

 

Sadie, Stanley, ed. The New Grove Dictionary of Music and Musicians. Vol. 12. London: Macmillan, 1980. 

 

Article from a Scholarly Journal (pgs. 187-191) 

➢ Footnote 

 1Max Deluch, “Mind from Matter,” American Scholar 47, no. 7 (Spring 1978), 343-44. 
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➢ Bibliography 

Deluch, Max. “Mind from Matter.” American Scholar 47, no. 7 (Spring 1978), 343-44.  

 

Magazine Article (pgs. 191-192) 

➢ Footnote 

 1John Smith, “Preparing for 2000,” Technology Today, March 10, 1994, 88. 

 

➢ Bibliography 

Smith, John. “Preparing for 2000.” Technology Today, March 10, 1994. 

 

Interviews and Personal Communications (pg. 197) 

➢ Footnote 
1Arthur Jones, interview by Ima Student, Dallas, January 21, 2008. 

 

➢ Bibliography 

No bibliography entry is needed for interviews.  

 

Internet Sources  

  

For the most part, the same important information for a printed source must be recorded for electronically 

accessed sources.  However, there are a few extra things that are very important to include.  For example, 

because the Internet is constantly changing, it is essential to record the date the information was accessed. 

 

When citing a document from the World Wide Web, include as much of the following information as possible. 

Some sources will not provide all of the information, so it is acceptable to omit missing details. If the material 

being cited does not have an author, for example, simply begin with the title of the document. 

➢ Author’s name 

➢ Title of document in quotation marks 

➢ Title of website from which the document was retrieved 

➢ Any other pertinent data about the source or contributors (journal title, volume, issue, editor, etc.) 

➢ URL 

 

General Website Format (pg. 194) 

➢ Footnote 
1Firstname Lastname, “Title of Article or Document,” Title of Complete Work or Website, Owner or 

Sponsor of Site, Publication or Revision date, www.url.com. 

 

➢ Bibliography 

Lastname, Firstname. “Title of Article or Document.” Title of Complete Work or Website. Sponsor of Site. 

Publication or Revision date. www.url.com. 

 

Note: if there is no date available, substitute with the accessed date (include “accessed” before the date). 

Note: do not include owner or sponsor of sight if it is the same as the title. 

 

Electronic Journal Article (pg. 187) 

➢ Footnote 

 1Ivana Novak, “Keeping Up with Bicarbonate,” The Journal of Physiology 528, no. 2 (October 20, 

2000): 250-55, http://www.jphysiol.org/cgi/content/full/528/2/235.  

http://www.jphysiol.org/cgi/content/full/528/2/235
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➢ Bibliography 

Novak, Ivana. “Keeping Up with Bicarbonate.” The Journal of Physiology 528, no. 2. (October 20, 2000): 250-

55. http://www.jphysiol.org/cgi/content/full/528/2/235. 

 

Article Obtained Through Electronic Database in DBU Library (pg. 190) 

➢ Footnote 

 1Francis Oakely, “The Great Papal Schism,” Christian History 9, no. 4 (June 13, 1990): 25, EBSCO. 

 

➢ Bibliography 

Oakley, Francis. "The Great Papal Schism." Christian History 9, no. 4 (June 13, 1990): 23-27. EBSCO. 

 

Social Networking (pgs. 195-196) 

➢ Footnote 
1Trisha Gracey (@trishagracey), “Make an appointment at the UWC,” Twitter, April 25, 2020, 6:04 

p.m., http://twitter.com/trishagracey.  

 

➢ Bibliography 

No bibliography entry is needed for social networking services. 

 

Using the Bible as a Source 

 

When using most biblical commentaries, follow the example for “A Multivolume Work.”  

 

When referring to whole chapters or books, (pgs. 351-354) 

Spell the complete name. Books and versions of the Bible are not underlined, italicized, or in quotations. 

Ex: The New Testament appeared in written form after Christ resurrected from the dead. 

Ex: This passage comes from the New American Standard Bible. 

Ex: The book of Hebrews claims no specific author. 

Ex: Proverbs 31 includes some of the most beautiful chapters in the Bible. 

 

When citing by verse,  

➢ Use abbreviations both in text and in notes.  

➢ List the chapter and verse separated by a colon (pg. 351). Always be consistent. Spell out the version the 

first time, and then use abbreviations in all subsequent references. 

➢ If the reference is given in the sentence, no footnote is necessary unless the version needs to be 

specified. 

 

 Ex: 1Gen. 1:1 (New American Standard Version) 
 2Rev. 1.1 (NASB) 

Ex. Genesis 1:1 says, “In the beginning God created the heavens and the earth.” 

 

Punctuation (pgs. 203-204, 352)  

Commas are used to indicate that only the listed numbers are being cited.  A hyphen is used to indicate 

inclusive numbers. 

 

Ex: Col. 3:16, 23 (only verses 16 and 23 are being cited) 

             Col. 3:16-23 (every verse from 16 to 23 is being cited) 

 

http://www.jphysiol.org/cgi/content/full/528/2/235
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Bibliography List and Notes (pg. 204) 

Biblical citations omit all facts of publication, including place (city), publishing agency, and date. 

➢ Footnote 

 62 Cor. 5:13 (King James Version). 

 

➢ Bibliography 

Usually the Bible is not included on the bibliography page, but it is acceptable to add it. 

 

*After spelling out the version once, abbreviate it in all subsequent footnotes. 

 

Citing a Study Bible (pg. 178) 

If citing the notes from a study Bible, one should cite it like an ordinary book with an editor as author. 

➢ Footnote 

   1W. A. Criswell, ed., The Believer’s Study Bible, New King James Version (Nashville: Thomas Nelson, 

1991), 35. 

 

➢ Bibliography 

Criswell, W. A., ed. The Believer’s Study Bible, New King James Version.  

Nashville: Thomas Nelson, 1991. 

 

Abbreviations (pgs. 352-354) 

Old Testament 

 
Gen. Genesis 1 Kings 1 Kings Eccles. Ecclesiastes Obad. Obadiah 

Exod. Exodus 2 Kings 2 Kings Song of Sol. Song of Solomon Jon. Jonah 

Lev. Leviticus 1 Chron. 1 Chronicles Isa. Isaiah Mic. Micah 

Num. Numbers 2 Chron. 2 Chronicles Jer. Jeremiah  Nah. Nahum 

Deut. Deuteronomy Ezra Ezra Lam. Lamentations Hab. Habakkuk 

Josh. Joshua Neh. Nehemiah Ezek. Ezekiel Zeph. Zephaniah 

Judg. Judges Esther Esther Dan. Daniel Hag. Haggai 

Ruth Ruth Job Job Hosea Hosea Zech. Zechariah 

1 Sam. 1 Samuel Ps. Psalms Joel Joel Mal. Malachi 

2 Sam. 2 Samuel Prov. Proverbs Amos Amos   

 

New Testament 

 
Matt. Matthew 2 Cor. 2 Corinthians 1 Tim. 1 Timothy 2 Pet. 2 Peter 

Mark Mark Gal.  Galatians 2 Tim. 2 Timothy 1 John 1 John 

Luke Luke Eph. Ephesians Titus Titus 2 John 2 John 

John John Phil. Philippians Philem. Philemon 3 John 3 John 

Acts Acts Col. Colossians Heb. Hebrews Jude Jude 

Rom. Romans 1 Thess. 1 Thessalonians James James Rev. Revelation 

1 Cor. 1 Corinthians 2 Thess. 2 Thessalonians 1 Pet. 1 Peter   

 

 

The authors of this handout consulted A Manual for Writers of Research Papers, Theses, and Dissertations, 9th ed. by Kate L. Turabian.  

Revised by Wayne C. Booth, Gregory G. Colomb, Joseph M. Williams, Joseph Bizup, William T. Fitzgerald, and University of Chicago 

Press Editorial Staff. Chicago: University of Chicago Press, 2018. 
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